
What is a p age layout?

A page layout (often referred to simply as a layout) is a collection of map elements organized

on a virtual page designed for map printing. Common map elements include one or more

data frames (each containing an ordered set of map layers), a scale bar, north arrow, map

title, descriptive text, and a legend. For geographic reference, you can add grids or graticules.

Elements of a page layout

Though page layouts can be exported and used electronically, they are primarily designed

for printing. Page layouts can have either a landscape (wide) or portrait (tall) orientation.

Page size varies depending on the specifications for the output. What you see on the layout

is what you get if you print or export the map to the same page size.

A page layout can also be used to author pages of a map book.
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Quest ions to consid er when d esign ing your layout

Here are some design considerations for working with map layouts:

• Will the map stand alone, or will it be part of a series of maps that share a similar

design? If your map has multiple pages, you should consider using Data Driven Pages.

• What size will the printed map be? Use this to set your layout's page size.

• How will the page be oriented? You can use the Page and Print Setup dialog box to

orient your page as either portrait or landscape.

• How many data frames will your map have?

• Will the map have other map elements such as a title, north arrow, and legend?

• Will the map contain graphs or reports to complement the geographic view of the
data?

• How will scale be indicated on the map?

• How will the map elements be organized on the page?

A q uick tour of p age layouts

A page layout (often referred to as a layout) is a collection of map elements organized on a

virtual page, designed for map printing. Common map elements that are arranged in the

layout include one or more data frames (each containing an ordered set of map layers), a

scale bar, north arrow, map title, descriptive text, and a symbol legend.

Map book pages
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Key elements of the page layout user interface

In Layout view you can add map elements such as north arrows, legends, and scale bars, as

well as, frames that contain the geographic data or the maps themselves. Other finishing

touches can be added to a Layout using a full suite of graphics and graphic editing tools.

Rulers and guides can be used in the Layout View to help you accurately measure and

organize the elements on the page. What you see on the layout is what you get if you print

or export the map to the same page size.

Creat ing a new p age layout

The first step in ArcMap is to change your map view to layout—either by selecting Layout

View from the View menu or by clicking the Layout View button on the lower left of the map

display. 3



In order to save time you may want to consider using a template to preconfigure your

layout. When starting a new document you can use one of the templates included with

ArcMap or create your own.

Layout templates

Using a template is optional. You can author your layout from scratch. 

Once you are working in layout view, you can set up your page orientation and dimensions

using the Page and Print Setup dialog box.

Tip :

Use the Change Layout button

placement of an existing layout.

on the Layout toolbar to change page orientation and element

Ad d ing a d ata fram e to the p age layout

The data frame displays a collection of layers drawn in a particular order for a given map

extent and map projection. You add a data frame to the page layout using the Insert

menu.
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From this menu, you can insert additional data frames. These additional data frames may be
for locator or

detail maps. If you are using multiple data frames you may want to consider using extent

indicators to show the extent of one data frame within another data frame. A good locator

map will also contain an indicator, such as an outline, showing where the extent of the detail

map fits within a larger extent. For example, your locator

map might show the location of a state within a country.

When your map document contains more than one data frame, only one will be the active

data frame, that is, the one with which you are actively working. The active data frame name

is shown in bold in the table of contents and the frame will be highlighted on the page with

a dashed outline. To make a data frame active, right-click on its name in the table of

contents and select Activate or single-click the data frame on the page layout.

Clicking once on a data frame in the layout selects it and allows you to access its graphic

properties. Eight selection handles will appear as squares at each corner and on each edge

of the frame. These handles can be used to resize the frame, and by clicking and holding

down the mouse cursor anywhere in the frame, you can reposition the data frame. Double-

clicking the data frame gives it focus. A black hatched line appears around the frame. This

allows you to interact with the map contents as you would if you were using data view.

Ad d ing o ther m ap elem ents to the p age layout

Use the Insert menu to select other map elements to add to your layout. You can use this

menu to add a Title to the page. The added text will be the same as the text entered for

the title in the Map Document Properties dialog box. Along with a title you can add (static)

Text and Dynamic Text.

Tip:
If you are in layout view and find that you can't select a graphic because it was added in data 
view, give the data frame focus.
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You can use the Insert menu to add a Legend, North Arrow, Scale Bar, and Scale Text. Clicking any

of these options opens an appropriate wizard or dialog box where you can set properties for

each map element.

You can also add neatlines, pictures, and objects from the Insert menu.

The Draw toolbar can be used to add graphic shapes such as rectangles, lines, and points.

You can also add graphic text and edit text properties.
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Working with m ap elem ents

As you add map elements, you can edit their properties, size, position, and appearance, and

arrange them on the page with other map elements. From the View menu you can toggle

on Rulers, Guides, and a Grid to aid you in positioning elements on the page. You can also

access placement aids in the layout view context menu. Open this menu by right-clicking the

page layout.

You can set properties for these placement tools using the Layout View tab of the ArcMap

Options dialog box, which is available from the Customize menu. Here, you can set the units

and division values for the page ruler, and set the spacing for the grid. You can also set a

snapping tolerance if you want your elements to snap to any one of the placement tools.

Options on the Layout View tab also include ways to manage the appearance of the layout

view. You can choose to stretch the contents of the view when the window is resized, and in

addition to displaying horizontal and vertical guides, you can choose to disable the display of

the dashed line around the active data frame.

To work with individual elements, select the element or elements you want to work with and

right-click to open the element context menu.
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Here you can zoom to, Cut, Copy, or Delete the selected element or elements from the page

layout. In some cases you may want to convert a dynamic element, such as a legend or scale

bar, to graphics in order to apply greater control over their display. The menu provides

options to Group or Ungroup elements. Grouping elements is a good way of managing a

page layout with many elements.

This menu also provides commands to further manipulate graphics through Graphic

Operations and placement commands. Placement commands include the ability to place

elements in a specified drawing Order, Nudge, or move the element in a particular direction,

Align, and Distribute multiple elements on the page. You can also Rotate or Flip an element.

You can change the size of map elements by selecting them and dragging the selection

handles. The cursor will change to an arrow when clicking and holding a selection handle.

Dragging a handle in either direction will resize the element. You can also use the element's

properties dialog box—Size and position tab—to position the element. Here, you can set an

anchor point, position the anchor on the page, adjust the height and width of the element,

and choose whether to preserve the aspect ratio of the element when it is resized.

Tip:
When you have more than one graphic selected, the blue handles indicate the dominant 
graphic, or the one that ArcMap will use to align other graphics. To change the dominant 
graphic, hold down the CTRL key and click the selected graphic that you want to be the 
dominant one.

Note:
You can only change the size, position, and frame of an element after it has been placed 
on the map.

Map element context menu
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Working with a p age layout

When in draft mode, using Toggle Draft Mode, the contents of the page elements are not

drawn. Instead, only the bounding box of the frame and a label showing its name are drawn.

This makes it faster to work with the page layout because you don't have to wait for the

contents of frames, especially data frames, to draw. You can control draft mode for individual

elements through the Frame tab of the element's Properties dialog box.

Layout context menu

The Layout toolbar is used to navigate the page layout. It is enabled when you are in layout view. 

You can pan and zoom in/out on the page. You can also jump back and forth to previous page 

extents or specify a zoom percentage based on the page size. Other options for navigating in the 

page layout include the Layout View context menu, changing the active tool into a navigation tool 

(link to navigation guide) by using the keyboard, and using the mouse wheel to zoom in and out.

You can access the layout context menu by right-clicking in any open area on the page. The layout 

context menu offers ways to work with the page layout. Along with access to the placement aids 

(Rulers, Guides, Grid, and Margins), this context menu provides a few commands to quickly 

change the view of the page, access the Page and Print Setup dialog box, Toggle Draft Mode, and 

work with selected elements.
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change with each page. Static elements stay the same. Any changes made to static elements of the layout

will be reflected on each page of the map series.

Grid s and Grat icu les

Grids and graticules are used to display coordinate positions on the earth. Graticules show lines of latitude and

longitude for the earth, while grids show measured locations based on a coordinate system or can be used as

a reference system for a grid index. For example, you can place a grid that divides a map into a specified

number of rows and columns by choosing the reference grid type.

ArcMap has three ways in which you can add grids and graticules to your map

• Grids and Graticule Wizard

• Custom overlay reference grids

• Grid and Graticule layers

Deciding which option to use depends on the requirements of the grid or graticule you want in your

map. 

Print ing and exp ort ing your layo ut

Once you have completed this work on your layout, you can print your map or create other types of

output formats—PDF files, PostScript files, or Illustrator files. Under the file menu you have the options to

open the Page and Print Setup dialog box, Print Preview, Print the page, or to Export Map.
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Creat ing a m ap layout

Below are the general steps for laying out a map in ArcMap:

1. Before starting in ArcMap, it's wise to design the arrangement of the elements onto

the map page and plan your layout.

2. Start by setting your layout's page size and dimensions. Create, edit, and symbolize

your data as appropriate in your data frame(s).

3. In layout view, click the Insert menu to add elements onto your layout. If you have

more than one data frame in your map, the elements you insert will relate to the

active data frame (to activate a data frame, right-click its name and choose Activate).

When you add map elements (for example, a scale bar), the map reflects your updates.

You can select, reposition, and modify map elements. Right-click a selected element to

access its shortcut menu and set additional options.

5. Add other text or graphics, such as notes, borders, and frames, using the Draw

toolbar. You can use guides, grids, and rulers to help you precisely position

elements on your page.

6. Print or publish your map.
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Essent ial p age layout vocab ulary

Below are some of the most common terms you will encounter when working with a page
layout in ArcMap.

Data Driven Pages

The ability to print, export, or preview multiple pages from a single layout using the

extents of features in a layer to dynamically update the extents of data frames on the

page.

Data fram e

A map element containing one or more data layers that defines a geographic extent, a

coordinate system, and other display properties.

Data view

An all-purpose display in ArcMap for exploring, displaying, and querying geographic data.

This view displays the contents within a data frame. Other elements that appear on the

page layout, such as titles, north arrows, and scale bars, are not displayed when in data

view.

Detail m ap

An additional map, displayed using a second data frame, that depicts an enlarged specific

geographic subarea at a larger scale to show more information than is possible in the main

map. Also called Inset map.

Dynam ic text

Text placed on a map layout that changes dynamically based on the current properties of

the map document, data frame, or Data Driven Pages, among other things.

Grat icule

A network of longitude and latitude lines on a map or chart that relates coordinates on a

map to their true locations on the earth.

Grid

In cartography, any network of parallel and perpendicular lines superimposed on a map and

used for reference. These grids are usually referred to by the map projection or coordinate

system they represent, such as universal transverse Mercator grid.
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Index layer

The layer that defines the extents for a set of Data Driven Pages.

Inset m ap

An additional map, displayed using a second data frame, that depicts an enlarged specific

geographic subarea at a larger scale to show more information than is possible in the main

map. Also called Detail map.

Layout

The arrangement of elements on a page. A map layout may include a title, legend, north

arrow, scale bar, and geographic data.

Layout view

In ArcMap, a display that shows the virtual page upon which geographic data and map

elements, such as titles, legends, and scale bars, are placed and arranged for printing.

Locator m ap

A supplemental reference map, or additional data frame, that provides spatial context to

the map reader by showing a larger recognizable area, or extent, than the detail map.

Also called Overview map.

Map elem ent

In digital cartography, a distinctly identifiable graphic or object in the map or page layout. For

example, a map element can be a title, scale bar, legend, or other map surround element.

The map area itself can be considered a map element, or an object within the map can be

referred to as a map element, such as a roads layer or a school symbol.

Map surround

Any of the supporting objects or elements that help a reader interpret a map. Typical map

surround elements include the title, legend, north arrow, scale bar, border, source

information and other text, and inset maps.

Overview m ap

A supplemental reference map, or additional data frame, that provides spatial context to

the map reader by showing a larger recognizable area, or extent, than the detail map.

Also called Locator map.
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Using m ap tem p lates

A map template is a map document (.mxd) from which new documents can be created.

Templates may contain basemap layers or be a variety of commonly used page layouts. Map

templates make it easy to reuse or standardize a layout on a series of maps. Using a

template can save you time, since you don't have to manually reproduce the common parts

of the maps. Like maps and layers, templates can be shared within an organization to

increase productivity and standardize the maps that the organization produces.

Creat ing a new m ap tem p late

Any map document (.mxd) can be used as a map template. To create a new template,

simply save or copy the map document into a special folder in your user profile. This will

create a template that only you can see. You can also add user-defined categories (folders)

to organize templates within the special folder. Copy the map document templates and

folders to the following location:

%APPDATA%\ESRI\Desktop<release number>\ArcMap\Templates

Alternatively, you can create templates for all users of the system listed under the Templates

node under New Maps. By default, system templates are located in the ArcGIS installation

directory; however, the ArcMapAdvancedSettings.exe can be used to change the default

location. This application is located in the Utilities folder of your ArcGIS installation directory.

System templates are initially located in the following location by default:

<install drive>:\Program Files\ArcGIS\Desktop<release number>\MapTemplates

New categories for templates are made available by creating folders beneath the

templates folder locations. Categories will only appear in the Getting Started, New Map,

and Change Layout dialog boxes if a map document is present in the folder under the

Templates or My Templates locations.

Tip :

You can save thumbnail images for your map template in ArcMap. Click File >

Map Document Properties and then click the Make Thumbnail button on the

Map Document Properties dialog box. Then save the map document.
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Select ing a tem p late in the Gett ing Started d ialog b ox

When you create a new document from a template, an untitled map is opened based on the

selected template. These templates are listed under the My Templates node under New

Maps.

The Select Tem p late dialog b ox

User and system templates are also available when changing your page layout in the Select

Template dialog box. New templates are available in the Select Template dialog box from

the same user profile and system location used by the Getting Started dialog box.

Open existing maps or create new maps from the Getting Started dialog box.
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To open the Select Template dialog box, click the Change Layout button on the Layout
toolbar.

Convert ing exist ing m ap tem p lates (.m xt files) to m ap docum ents

To convert your .mxt files, open the file from the Catalog window as an untitled map

document and save it to the file system.

Change your page layout with a user-defined template under My

Templates or a system template from Templates.
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Map elem ents

Each map element has a name used to identify the element. For example, when the layout is

in draft mode,  each element is drawn as a hollow frame containing the name of the element.

By default, the name is based on the element type, such as Scale Line or North Arrow, but you

can change it to a unique or more descriptive name on the Size and Position tab of the

element's Properties dialog box. The element name is also very important for map

automation scripts using the arcpy.mapping module. Map automation scripts use the names

of elements to identify which elements are to be modified by the script.

A data frame's name property is always the same as what's shown in the table of contents.

Therefore, updating the name inside the Data Frame Properties dialog box will also update

its name in the table of contents.

Map elements aren't always the size you want when they're added to a map. You can

change the size of map elements by selecting them and dragging the selection handles.

Dragging a handle away from an element enlarges it, while dragging a handle toward an

element reduces it. You can only change the size, position, and frame of an element after it

has been placed on the map. If you click Properties while inside the initial configuration

dialog box of a scale bar, for example, you won't see the Size and Position tab or the Frame

tab.

North arrows

North arrows indicate the orientation of the map. A north arrow element maintains a

connection to a data frame. When that data frame is rotated, the north arrow element

will rotate with it. North arrow properties include its style, size, color, and angle.

The size of the north arrow is in points. Decimal fractions can be entered here.

You can control the alignment of the north arrow by selecting one of the following options:

• Data Frame Rotation—North arrow angle uses the rotation of the data frame.

• True North—North arrow angle uses geodetic north, or the direction to the north

pole. The true north calculation is based on the coordinate system using the center

point of the data frame.

Use Calibration Angle to manually set the rotation angle: 0 to 360 degrees rotates clockwise,

0 to -360 rotates counterclockwise. Decimal fractions can be entered. This is a user-defined

angle and can be used, for example, to show magnetic declination by entering the angle

magnetic north deviates from true north.

Calculated Angle shows the rotation angle of the north arrow. This angle is calculated

automatically using either true north or the data frame rotation. This value is read only.
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Scale bars

Scale bars provide a visual indication of the size of features and distance between features

on the map. A scale bar is a line or bar divided into parts and labeled with its ground length,

usually in multiples of map units such as tens of kilometers or hundreds of miles. If the map

is enlarged or reduced, the scale bar remains correct.

When you insert a new scale bar onto a map, this defaults to the Display Units specified on

the General tab on the Data Frame Properties dialog box.

When you add a scale bar to a map, the number and size of the divisions might not be

exactly as you want them. For example, you might want to show four divisions rather than

three or show 100 meters per division instead of 200. You might also want to change the

units that the scale bar shows or adjust how those units are represented. You can adjust

many characteristics of a scale bar from the Scale Bar Properties dialog box.

You can control the behavior of the scale bar when it is resized or when the map scale

changes by selecting one of the following options:

• Adjust width—Preserves the division value and number of divisions; adjusts scale bar

width if map scale changes

• Adjust division value—Preserves the number of divisions and tries to preserve

scale bar width by adjusting the division value

• Adjust number of divisions—Preserves the division value and tries to preserve

scale bar width by adjusting the number of divisions

When you add a scale bar to a map, the number labels and tick marks might not be exactly

as you want them. For example, you might want to label the endpoints of the scale bar but

not the divisions, or you might want larger tick marks at the major divisions of the bar than

at the minor ones.

By default, the units label on a scale bar is the same as the scale bar units. Sometimes you

might want to change the label of the scale bar, for example, from Kilometers to km. Just

type the new scale bar label in the Label text box. To control the distance between the label

and the bar, enter a value in the Gap text box. This is either vertical or horizontal depending

on the unit label position. Positive gaps move the label to the right or upwards; negative

gaps move the label to the left or downwards.
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Scale text

You can also represent the scale of your map with scale text. Scale text indicates the scale of the 
map and features on the map. Scale text tells a map reader how many ground units are 
represented by a map unit—for example, 1 centimeter equals 100,000 meters.

Scale text can also be an absolute ratio independent of units, such as 1:24,000. This means one 
unit on the map is equal to 24,000 of the same units on the ground. The advantage of absolute 
scale text is that map readers can interpret it with any units they want.

One drawback of scale text is that if a printed copy of the map is duplicated at another scale 
(enlarged or reduced), the scale text will be in error. Scale bars do not suffer from this limitation. 
Many maps have both scale text and a scale bar to indicate the map scale.

Legends

A legend tells a map reader the meaning of the symbols used to represent features on the map. 
Legends consist of examples of the symbols on the map with labels containing explanatory text. 
When you use a single symbol for the features in a layer, the layer is labeled with the layer's
name in the legend. When you use multiple symbols to represent features in a single
layer, the field you use to classify the features becomes a heading in the legend, and each
category is labeled with its value.

Legends have patches that show examples of the map symbols. By default, the legend

patches are points, straight lines, or rectangles that match the map symbols. You can

customize the legend patches, for example, so areas are represented with patches of

another shape, or rivers are drawn with a sinuous rather than a straight line.

When you have more than one data frame, inserting a legend adds a legend for the

selected data frame. Each legend corresponds to a single data frame, although you can

arrange multiple legends together as a single legend for a complex map.

You can change the text symbol used by multiple legend items using the Items tab of the

Legend Properties dialog box. You can change the text symbol of all the items in the

legend or just the ones you have selected in the list. A drop-down list lets you choose

the parts of the legend items to which you want the text symbol to apply. If you want

your description to be on more than one line, insert a line break by pressing CTRL+ENTER

in the Description text box on the Legend dialog box.

You can edit the text of the labels that appear in the legend by changing the text in the

ArcMap table of contents or on the Symbology tab of the Layer Properties dialog box.

Legend text can be formatted using Esri text formatting tags.

19



If you want an additional description of single symbol layers to appear in your legend, choose

a legend item style that includes a description. To add a description, right-click the layer to

which you want to add descriptive text in the table of contents, click Properties, then click the

Symbology tab on the Layer Properties dialog box. If you are using the Single symbol method,

click the Description button. If you are using a drawing method other than Charts, right-click a

symbol after you have specified its symbology options and click Edit Description. The text you

enter appears next to that symbol in the legend; the text won't appear in the table of

contents.

Transparency in legends

If you have layers with transparency in your map, ArcMap simulates the transparent

colors in your legend. When layers in a data frame are made transparent, the table of

contents and the legends in layout view automatically use lighter colors to reflect

transparency.

The option to simulate transparency in legends is set on the General tab on the Data Frame

Properties dialog box. When this option is turned on, solid, bright red polygons drawn on a

layer appear in the legend as a light red or pink, depending on the percentage of

transparency applied to the layer. However, with the Simulate transparency option off, the

legend still shows the solid red polygon symbol, even though the polygons don't appear red

on the map because the layer is transparent.

By default, this setting is off (unchecked) for maps created with versions of ArcGIS prior to 9.3,

but you can turn it on if you want. This setting is automatically checked on for new data

frames you create in existing map documents.

In addition, you can convert the legend to graphics and manually specify the legend patch

colors. Using the Eye Dropper tool, you can obtain the exact RGB value of a pixel and use that

color for the legend patch.
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Frames

Certain map elements—including scale bars, scale text, north arrows, legends, and data

frames—can have frames. Frames allow you to choose a border, background, and drop

shadow for the element. You can use frames to set map elements apart from other

elements or from the background of the map. You can also use frames to visually link map

elements to other parts of the map by using similar frames for related elements.

Convert ing m ap elem ents to grap hics

You might want to convert a map element, such as a legend, to graphics if you want more

precise control over each item that composes the map element.

It is important to note that once you convert a map element into a graphic, it is no longer

connected to its original data and will not respond to changes made to the map. For

instance, with a legend element, if you decide to add another layer to the map after the

legend has been converted to a graphic, the legend will not automatically update. It will

have to be deleted and rebuilt again using the Legend Wizard. Therefore, it is a good idea

to convert elements to graphics only after your map's layers and symbology are finalized.

The image below shows a legend that has been converted to a graphic:

You can further ungroup the legend graphics so the individual elements (the patches,

text, and so on) that compose the legend can be edited individually.
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Working with d ata fram es in p age layouts

In layout view, you normally work with layout graphics and text, so when you switch to layout

view, the ArcMap graphic tools initially apply only to these text elements. For example, if you

use the Select Elements tool in

layout view, by default, it will only select layout graphics and text. Graphics and text stored in

the data frame or in a geodatabase annotation feature class won't be selected. In addition, if

you add new text or graphics in layout view, they will be added to the layout by default.

However, you can add focus to your data frame to allow you to work inside the data frame.

Focusing allows you to work as if you were in data view without having to switch from layout

view.

Focusing a data fram e

In layout view, focusing the active data frame allows you to work with the features and

elements in that data frame as though you were in data view. You can create, delete, and edit

features, graphics, and text in a focused data frame.

When working in layout view with an unfocused data frame, text and graphics that you draw

are added to the page layout, stored in the units of the page, and won't appear if you

switch to data view.

With a focused data frame, you can make additions and modifications to your map in the

context of your map layout. For example, suppose you've used the Text tool to identify an

ocean in data view, but in layout view, you see that the text is too close to the edge of the

data frame. To correct this, you can simply put the data frame into focus and move the piece

of text while you're still in layout view rather than switching between views.

When a data frame is in focus, a thick, diagonal line border will appear around it.

Only one data frame can be in focus at a time. A data frame that is in focus will always also

be the active data frame. All the commands that operate on the contents of a data frame

when it is active also work when the data frame is in focus.
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Custom izing d ata fram es

Ab out custom izing data fram es

In layout view, you see geographic data in a data frame on the virtual page. You can use

the data frame to emphasize the geographic data on the map by adding a border,

background, or drop shadow.

Adding a b order to a data fram e

1. Right-click the data frame in the table of contents and click Properties.

2. Click the Frame tab on the Data Frame Properties dialog box.

3. Click the Border drop-down arrow and choose a border symbol.

4. Click the Color drop-down arrow and choose a color.

5. Type an x and y gap to offset the border from the edge of the data frame.

6. Type a value for Rounding; this is the percentage to round the corners of the border.

7. Click OK.

Adding a b ackground to a data fram e

Setting a background can be very important if you are creating a map service that will be

overlaid on top of other data. In such cases, you should explicitly set a data frame

background color instead of leaving the default null background color. The map service will

treat the background color as transparent, so avoid choosing a color found elsewhere in your

map. To avoid white areas of your map becoming transparent, you can set the background

color to near-white (example: RGB 254, 255, 255).

1. Right-click the data frame in the table of contents and click Properties.

2. Click the Frame tab on the Data Frame Properties dialog box.

3. Click the Background drop-down arrow and choose a background.

4. Click the Color drop-down arrow and choose a color.

5. Type an x and y gap to offset the border from the edge of the data frame.

6. Type a value for Rounding; this is the percentage to round the corners of the border.

7. Click OK.

Adding a drop shadow to a data fram e

1. Click the data frame in the table of contents and click Properties.

2. Click the Frame tab on the Data Frame Properties dialog box.

3. Click the Drop Shadow drop-down arrow and choose a drop shadow.

4. Click the Color drop-down arrow and choose a color.

5. Type an x and y gap to offset the border from the edge of the data frame.
6. Type a value for Rounding; this is the percentage to round the corners of the border.

7. Click OK.
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Working with g rap hic elem ents, neat lines,

p ictures, and ob jects

Maps can feature graphic elements, neatlines, pictures, and objects in addition to

geographic data, scale bars, and other typical map elements.

Grap hic elem ents

Graphics can be used to do the following:

• Ornament a map.

• Group related parts of a map together.

• Identify a map with an organization.

• Emphasize a part of the map.

Grap hic rectang les

You can use graphic rectangles (neatlines) to frame a group of other map elements. If you

want to frame an individual map element, right-click it, click Properties, then click the

Frame tab. You can use this method to choose borders and backgrounds for legends,

north arrows, data frames, scale bars, and scale text.

Pictures

Maps can have pictures, or graphic images, in addition to the geographic data on the map.

You might add a graphic image of your company's logo to indicate the source of a map or add

a nation's flag to a map to indicate its subject. You can also ornament a map by placing

representative images of places, people, or objects found in an area on a map. The formats

you can insert include JPEG, GIF, TIFF, EMF, BMP, PNG, and JPEG 2000.

You have the option to save the picture as part of the map document. To do this, double-

click the picture and click the Save Image as Part of Document check box. This is unavailable if

the picture was pasted into the map instead of being inserted using the Insert > Picture

command. It is also unavailable if the source for the picture can't be found.

If you choose not to save the picture in the document, ArcMap references the picture on disk.

This means that if the picture's disk location is changed, or if the map is moved to a new disk

location from which ArcMap cannot access the picture, the picture is unavailable, and you'll

get a message about this whenever you open the map or access the properties of the

picture.

By default, ArcMap does not save the image with the map document.
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If you are using Data Driven Pages you can make your picture element dynamic and have it

update for each page. To do this, double-click the picture and go to the Picture tab. There

are two options from which you can choose from: Simple path from Data Driven Pages and

Attachment from Data Driven Pages.

Simple path from Data Driven Pages allows you to choose a field from the Data Driven Pages

index layer that contains either a path or URL that references the image you want to use for

each page. You can also reference a raster field as well.

Attachment from Data Driven Pages allows you to reference images that you have as

attachments on index layer features. In cases where you have more than one attachment for

a feature you should use the Name filter. For example, you can filer on the file type (.png) or

on a portion of text in the name (PictureInsert).

Ob jects

You can easily add data of almost any type to your map as an object and edit the data using

the application to which it belongs. For example, suppose you have a Microsoft PowerPoint

slide you want to add to a map. You could select the elements on the slide, copy them, then

paste them into the map; however, using this method, you wouldn't be able to edit the

pasted slide because it would no longer be in PowerPoint format. By inserting the slide as an

object instead, you can add it to your map and simply double-click it to make changes to it

using PowerPoint.

When you insert an object, you can either create a new, empty object or insert an existing file.

The option you choose depends on the type of object you want to insert. In the case of

inserting a PowerPoint slide, you can insert an existing presentation file as an object, but only

the first slide in the presentation is visible on your map. Alternatively, you can insert a new

PowerPoint slide, double-click it to edit it in PowerPoint, then paste all the elements of your

existing slide into this slide.
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Working with legend s

A legend tells a map reader the meaning of the symbols used to represent features on the

map. Legends consist of examples of the symbols on the map with labels containing

explanatory text. When you use a single symbol for the features in a layer, the layer is labeled

with the layer's name in the legend. When you use multiple symbols to represent features in

a single layer, the field you use to classify the features becomes a heading in the legend, and

each category is labeled with its value.

Legends have patches that show examples of the map symbols. By default, the legend

patches are points, straight lines, or rectangles that match the map symbols. You can

customize the legend patches, for example, so areas are represented with patches of

another shape, or rivers are drawn with a sinuous rather than a straight line.

A quick tour of the Legend Wizard

The Legend Wizard provides an easy, quick way to add a legend to your map. The wizard
allows you to

• Choose which map layers you want to be part of the legend.

• Set the number of columns in the legend.

• Create and symbolize a legend title.

• Create and symbolize a border and background for the legend.

• Customize the shape and size of legend patches.

• Set the spacing between legend elements.

When you first access the wizard, you will see the list of layers in your map that will make
up the legend.
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Not all layers need to be in the legend. You have the option to remove any of the layers

listed. You can reorder the layer list as you see fit. This reordering does not affect layer

ordering in the table of contents. This panel of the wizard also provides options to set the

number of columns in the legend. The wizard does not provide options to determine where

columns begin. You can further refine your columns by modifying the legend after it has been

created using the options on the Items tab of the Legend Properties dialog box.

The next panel provides a place for you to enter a legend title.

Tip:
Click Preview to see what the legend will look like. Click the button again to remove the 
preview legend.
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Along with typing in the title text, you can choose the color, size, font, and justification of the

text. The next panel offers choices to customize a border, background, and drop shadow for

the legend.

The next to last panel gives you the opportunity to set patch properties for line and polygon
symbols.
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Here, you can set the width, height, and shape of the patch for line or polygon features. The last

panel allows you to specify the spacing between legend elements.

As you click each spacing input box, the spacing indicator (in red) in the image to the right will

adjust to show you where the spacing will be adjusted.
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Transparency in  Legends

If you have layers with transparency in your map, ArcMap simulates the transparent

colors in your legend. When layers in a data frame are made transparent, the table of

contents and the legends in layout view automatically use lighter colors to reflect

transparency.

The option to simulate transparency in legends is set on the General tab on the Data Frame

Properties dialog box. When this option is turned on, solid, bright red polygons drawn on a

layer appear in the legend as a light red or pink, depending on the percentage of

transparency applied to the layer. However, with the Simulate transparency option off, the

legend still shows the solid red polygon symbol, even though the polygons don't appear red

on the map because the layer is transparent.

In addition, you can convert the legend to graphics and manually specify the legend patch

colors. Using the Eye Dropper tool, you can obtain the exact RGB value of a pixel and use that

color for the legend patch.

Modifying legend p rop ert ies

Using the Legend Properties dialog box, you can

• Change the wording, symbology, and position of the legend title.

• Change properties for patches.

• Change the reading orientation.

• Adjust the spacing between legend elements.

• Change the presentation style.

• Add or remove columns.

• Change text symbology for selected items.

• Determine the interactive behavior of the legend through its connection with the map.

• Determine the interactive behavior of the legend with the current map extent.

The Legend Properties dialog box has five tabs: General, Items, Layout, Frame, and Size and
Position.
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Currently, only one position for the title, above, is supported. You can convert the legend to

graphics and rearrange legend components manually if you want to reposition the title. You

can also choose not to include a title as part of the legend and create a title as an

independent graphic element.

To specify which layers will appear as items in your legend, use the buttons between the lists

of map layers and legend items. Layers in your map that can be legend items will appear in

the Map Layers list. The layers listed in the Legend Items list reflect the actual make up of your

legend. To reorder one or more items in the legend, select the items in the Legend Items list,

and click the buttons to the right of the list to move them up and down or to the top or

bottom of the list.

There are also four options available to adjust the behavior of the legend based on changes
made to the map:

• Only display layers that are checked on in the table of contents.

• Add a new item to the legend when a new layer is added to the map.

• Reorder the legend items when the map layers are reordered.

• Scale symbols when a reference scale is set.

You can choose to only display layers that are checked on in the table of contents. If a layer's

visibility is turned off, it will automatically be removed from the legend; otherwise, layers will be

shown in the legend whether or not they are visible on the map. You can also have the legend

add a new item to the legend automatically when a new layer is added to the map. Another

option is to reorder legend items automatically whenever the map layers are reordered in

the Table of Contents. Lastly, you can choose to scale symbols in the legend when a reference

scale is set in the map. This will match the size of line and point symbols in the legend to the

size of line and point symbols on the map. This only applies when the map has a reference

scale. Without a reference scale set, the size of symbols in the map and the legend will remain

constant.

The General tab provides a way to 
customize the legend title, specify 
legend items, and set the map 
connection properties.
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On the Items tab, you can customize individual legend items, change text symbology,

change how items interact with the current map extent, and change column settings at

the item level.

While working in the Items tab, you can apply changes to one or more items at a time.

When you select multiple items from the list, the changes you make will apply to all the

selected items. Settings you do not change will remain the same as they were for each

individual item.

To change the text symbol used by some or all of the items, use the font controls next to the

item list. You can apply these changes to all the text associated with the selected items, or

just to particular text items. These include the layer name, the heading, the label, and the

description. Use the drop-down menu to select which text items you would like to change.

You can also modify all the text symbology in the legend at once by using the font

controls on the Draw toolbar while the legend is selected in your layout.

The Map Extent Options allow you to control how eligible legend items interact with the

current map extent. If the Only show classes that are visible in the current map extent check

box is checked, a legend item class will only appear in the legend if a feature from that class is

in the current extent. If no features from that legend item are in the current extent, the

entire item will be removed from the legend. You can also add feature counts to your legend

by checking the Show feature count check box.
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Note:
When counting and determining if features are in the current extent, the feature geometry, not 
symbology, will be used for polygon and line features. This means if part of a feature's symbol 
appears inside the data frame but the geometry does not, such as with a buffer or an offset, the 
feature will not be included in the count.

Point features will be counted using their symbology and not their geometry. For example, if

a point feature is in the current extent but has an offset that moves its symbol out of the

current extent, the symbol will not be counted.

The number of features from that legend item class that are in the current extent will appear

after that class' label. If a legend item does not have labels, the count will appear after the

patch. You can set the text that will appear before and after the feature count by typing in the

text boxes. You can also set whether or not you would like to display a thousands separator

by checking or unchecking the Show thousands separator check box. If Data Driven Pages is

enabled, you can check the Use current index as the map extent (data driven pages) check

box to use the extent of the current index feature as the current map extent. By default, the

current

extent of the data frame is used. If the data frame is clipped, the current clip shape will be

used as the extent. Layers that are excluded from the clip will still use the full extent of the

data frame.

This tab is also where you can control the number of columns in your legend. You do this by

placing items in new columns and setting the number of columns for each item. To place

an item in a new column, select it from the list and check the Place in new column check

box. You can also enter the number of columns you want to use for each legend item. Use

these properties on individual legend items to achieve your overall desired column

configuration.

To change the legend item style, double-click the item listed in the Legend Items list box. This

takes you to the Legend Item Selector dialog box.

Caution:
The number of columns set in the Legend Wizard works on the entire legend. The number of 
columns entered on the Items tab of the Legend Properties dialog box is applied to a single legend 
item. This legend item may have many parts; for example, the legend item may represent cities 
broken into five classes based on population. Entering a number greater than the number of parts 
in the legend item will have no effect.

Tip:
You can also access the Legend Item Selector dialog box by clicking an item or selecting multiple 
items by using SHIFT or CTRL and clicking the Style button.
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Here, you can select and preview the legend style you want to use for the chosen legend

item. As you select an arrangement from the left, you will see a preview on the right. To make

further modifications, click Properties. This brings up the Legend Item Properties dialog box.

Using this dialog box, you can further customize the arrangement and appearance of legend

items.

The Arrangement tab provides six options for the arrangement of the patch, label, and

description. The General tab allows you to hide, display, and change the text symbology of the

layer name, labels, headings, and description. You can also override the default patch for line

and polygon features. Other options on the General tab include the ability to show classes

from a specific heading if the layer has been divided under headings on the Symbology tab of

the Layer Properties dialog box and to prevent items from being split across legend columns.

34



Tip:

If you customize line or polygon patches on the Legend tab, the changes will be

applied to all line or polygon symbols in your legend. If you want to override the patch

shape for specific layers, use the legend item properties by right-clicking the legend

item on the Items tab and selecting Properties. Then click the General tab on the

Legend Item Properties dialog box.

Tip :

You can also access these properties by right-clicking the legend item on the Items

tab and selecting Properties.

On the Layout tab, you can set the default legend patch, set the spacing between legend

elements, set the fitting strategy, and set the legend to read right to left.

You can set the default width, height, and shape of the patch for line and polygon features

for all legend items. To override the default legend patch, open the Legend Item Properties

dialog box for an item and check Override default patch.

You can also specify the spacing between legend elements. As you click each spacing input

box, the spacing indicator in the image to the right will update to show you where the

spacing will be adjusted.
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After applying these values, the legend will resize to meet them. However, if you resize the

legend afterwards the values will adjust accordingly.

You can also adjust the way legend items fill the bounding box. By default, legend items will

take up the entire frame. Legend items will grow or shrink as you resize the legend frame and

the bounding box will grow or shrink when items are added or removed from the legend.

However, if the Fixed Frame option is selected, the frame size will remain fixed, and as legend

items are added or removed, they will adjust to fit inside. It is important to remember that

this means it will try to make the legend as compact as possible, not that it will try to take up

the entire bounding box. Instead of resizing legend item elements to fill the frame; font size,

default patch size, and gap measurement values will be used as maximum values. After the

entire frame is taken up using these values, legend items will begin to drop. The following

symbol will appear if any items have been dropped from the legend .

When fitting the legend into the frame, column settings for individual legend items will be

respected unless Automatically Adjust Number of Columns is checked. With Automatically

Adjust Number of Columns checked, column settings for individual items will be overridden

and a new column will be made whenever the entire height of the legend frame is taken up.

If Shrink Contents to Fit is checked, legend contents will shrink in an attempt to fit more

items on the legend until a minimum font size is hit. Once this font size is hit by any legend

text item, the legend will begin dropping legend items that do not fit.

When a border, background, or drop shadow is added to a legend with Fixed Frame enabled,

they will resize to surround the legend items and not the bounding box.

Note:
Even if part of an item does not fit, the entire legend item is going to be dropped from the 
legend. For example, if only 10 classes from a 15 class legend item will fit, the entire item will 
be dropped, not just the 5 classes that do not fit. At this point the legend will stop trying to add 
items even if another legend item later in the list would fit. Keep this in mind when ordering 
your legend items.
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and Wrap descriptions, respectively, and setting maximum width values. The label and

description widths will be used along with patch and gap measurements to set your total

column width. If a column does not have labels or descriptions, the label and description

widths will not be added to the total width of those columns. Text will wrap after it reaches

the limit using standard character breaks. If a piece of text doesn't fit, it will be truncated

with an ellipsis. The measurements you set for description and label width will remain

constant even if you resize the legend frame. They will not adjust proportionately like other

measurements.

By default, the legend is set up to read left to right. To have it read right to left, check the

Right to left reading check box.

Finally, the dialog box contains two standard tabs for setting the frame (border and

background) and the size and position of the legend.

Convert ing m ap elem ents to grap hics

You might want to convert a map element, such as a legend, to graphics if you want more

precise control over each item that composes the map element.

It is important to note that once you convert a map element into a graphic, it is no longer

connected to its original data and will not respond to changes made to the map. For

instance, with a legend element, if you decide to add another layer to the map after the

legend has been converted to a graphic, the legend will not automatically update. It will

have to be deleted and rebuilt again using the Legend Wizard. Therefore, it is a good idea

to convert elements to graphics only after your map's layers and symbology are finalized.

You can further ungroup the legend graphics so the individual elements (the patches,

text, and so on) that compose the legend can be edited individually.

Note:
When either label or description wrapping is enabled, wrapping is automatically enabled for 
headings and layer names as well. They will wrap to the total width of the item.

Legend titles will also wrap to the total width of all the columns.

The image shows a legend
that has been converted to
a graphic:
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How to change the num ber of colum ns in your legend

Though you can set the number of columns in your legend when you are first creating it

using the Legend Wizard, you may find that you want to further refine your columns. You

can do this using legend properties.

1. Double-click the legend to bring up the Legend Properties dialog box.

2. Select the layer from Legend Items that you want to start a column.

3. Check the Place in new column check box.

4. Repeat this for each additional layer in which you want to start a column.

How to change the properties for a single legend item

1. Double-click the legend to bring up the Legend Properties dialog box.

2. Click the Legend tab on the Legend Properties dialog box.

3. Right-click the item from Legend Items in which you want to edit and click Properties.

4. Make your changes using the Arrangement and General tabs.

How to turn on transparency sim ulation in your legend

1. Right-click the data frame in the table of contents and click Properties.

2. Click the General tab.

3. Check the Simulate layer transparency in legends check box.

Optionally, uncheck the Simulate layer transparency in legends check box if

you do not want transparency simulation in your legend.

Adding m ixed-form at text to legend descriptions

1. Edit the class descriptions and enter some formatted text. To add a description, right-

click the layer to which you want to add descriptive text in the table of contents, click

Properties, then click the Symbology tab on the Layer Properties dialog box.

2. If you are using the Single symbol method, click the Description button. If you are using

a drawing method other than Charts, right-click a symbol after you have specified its

symbology options and click Edit Description.

3. The text you enter here appears next to that symbol in the legend; the text won't

appear in the table of contents. If you want your description to be on more than one

line, insert a line break by pressing CTRL+ENTER while on the Description for Legend

dialog box.

4. Click OK on the Layer Properties dialog box to apply the symbology to your layer.

Caution:
Any values entered into Columns under the Legend Properties dialog box only affect the selected item. 
Do not use this control to define the number of columns for the entire legend. The total number of 
columns in the legend can be defined when first creating the legend in the Legend Wizard or by using 
the Place in new column check box outlined in the steps above.
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Wo rkin g wit h le g e n d p a t ch sh a p e s

Legend patch shapes are the geometric shape of either a line or a polygon that is used to

represent a specific kind of feature in a legend or in the table of contents. You can choose

to use any of a variety of predefined legend patch shapes in ArcMap.

Different legend patch shapes may be more appropriate given the type of data you are

representing in your maps. For instance, natural features, like lakes or ponds, have

amorphous shapes, and often, it is cartographically more appropriate to represent these

features in a legend with such a shape rather than a rectangle.

Changing p atches for a legend

You can choose to change the legend patch for all items in a legend or for a part of the
legend.

Chang ing t he legend p atch shap e for all o f a legend

1. Right-click the legend in layout view and click Properties.

2. Click the Legend tab on the Legend Properties dialog box.

3. Click the Line or Area drop-down arrow in the Patch section to choose the patch
shape.

Optionally, change the height and width of the patch shape.

4. Click OK.
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The table of contents can be set to use a 
specific patch shape for all line and 
polygon layers.

Legends in ArcMap can be set to use 
specific shapes for each layer or even a 
set of features that fall under a different 
heading when the unique values 
symbology method is used.

Changing the legend patch shape for part of a legend

1. Right-click the legend in layout view and click Properties.

2. Click the Items tab on the Legend Properties dialog box.

3. Click the name of the item in the Legend Items list for which you want to
change the patch shape.

4. Click Style.

This will open the Legend Item Selector dialog box.



5. Click Properties.

6. Click the General tab on the Legend Item dialog box.

7. Check Override default patch.

8. Click the Line and Area drop-down arrows to choose a different patch for your legend
item.

Optionally, check Override default patch size and type a new width and height
for the legend patch.

9. Click OK on all dialog boxes.

Changing p atches for the tab le of contents

You can also change the patches displayed in the table of contents. Changes made for the

patch shapes in the table of contents do not affect the shapes used in the legend.

Cho osing a d ifferent legend p atch shap e fo r t he tab le of content s

1. Click the table of contents Options button.
If the table of contents is not displayed, you can display it by clicking Windows >
Table of Contents.

2. Click the Patches tab on the Table of Contents Options dialog box.

3. Choose the patch shape from the Patch Shape section you want to use in the table of
contents.

Optionally, change the height and width of the patch shape within the Patch
Size section.

4. Click OK.

Creat ing a new legend p atch shap e

You are not restricted to using the shapes listed. You can create new shapes to use.

Creating a new legend patch requires that you use the New Legend Patch Shape

command. After this, you can create a new legend shape using either a graphic or selected

features.

Ad d ing the New Legend Patch Shap e com m and to your user interface

1. Click Customize > Customize Mode from the main menu.

2. Click the Commands tab on the Customize dialog box.

3. Scroll through the Categories list and click Page Layout.

4. Scroll through the Commands list and click and drag the New Legend Patch Shape

command to any toolbar.

5. Click Close.

Creat ing a new legend p atch shap e from a feat ure

1. Click the Select Features tool     .
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2. Select one or more line or polygon features.

The outline of these features will become the shape of the legend patch.

3. Click the New Legend Patch Shape button.

4. Click the Outline of Features option.

5. Click the Layer drop-down arrow and click the layer that contains the selected
feature or features.

6. Click the Features drop-down arrow and click selected.

7. Click Create Patch.

8. Optionally, uncheck the Preserve Aspect Ratio check box. This will allow any later

changes using the patch height and width to stretch the shape you have created.

9. Click Add to Styleset.

10. Type a name for the new patch shape and click OK.

11. Click Close.

The newly created patch shape, created either from a graphic or from a feature, can now be

accessed and used the same way the default patch shapes are used.

Creating a new legend patch shape from a graphic elem ent

1. Use the drawing tools to create a graphic in the shape of the legend patch shape you
want.

2. Click the Select Elements tool on the Draw toolbar.

3. Click the graphic.

4. Click the New Legend Patch Shape button.

Optionally, uncheck the Preserve Aspect Ratio check box.

This will allow any later changes using the patch height and width to stretch the shape
you have created.

5. Click Add to Styleset.

6. Type a name for the new patch shape and click OK. 41
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Working with tab le elem ents

A table can complement a map with information about the area or objects of interest. A

table consists of rows and columns or records and fields. For spatial data, each record

represents a feature and each field represents an attribute of the dataset. Nonspatial (or

stand-alone) tables look and behave the same, the only difference being that they do not

contain a spatial attribute.

Tables are dynamically linked to the dataset from which they have been added and will

update automatically if edits are made to the data. If the table is from a data source that is

not editable in ArcGIS, it will not automatically update on the layout.

Contro lling how tab les are disp layed

The font, color, and cell spacing of a table can be set for a specific table from the Table

Appearance dialog box (click the Table Options menu on the Table window and choose

Appearance to open the dialog box). If you want to control the font, color, and cell spacing

properties for all tables, choose the ArcMap Options command from the Customize menu

and adjust the settings on the Tables tab.

To control what fields are visible, the field alias and numeric settings (like number of decimal

places) for a table bring up the Layer Properties dialog box for a layer. On the Fields tab of the

dialog box, uncheck fields to turn off visibility and adjust the alias and numeric format of a

field under Appearance. These properties will be respected by the Identify window, attribute

Table window, and other places where attributes are used in ArcMap.

Once a table element has been added to the layout, it can be resized and repositioned by

dragging the element or its respective handles. To preserve the aspect ratio of the element,

you can right-click it and choose Properties. On the Properties dialog box, click the Size and

Position tab and check the Preserve Aspect Ratio option.
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Using a Microsoft Excel ob ject

Objects allow you to add data of almost any type to your map while being able to edit the

data using the application to which it belongs. A common way to add tabular data to a

layout is to use a Microsoft Excel object. To add an object, click Insert on the main menu and

choose Object. From the Insert Object dialog box, you can choose to create an object from

file and you can then specify the file. If you choose an Excel file that contains more than one

worksheet, the first worksheet will be added to the layout as an object.
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Tip:

When resizing an inserted object, hold down the SHIFT key to preserve the object's
aspect ratio.



Custom izing your m ap extent

A map extent defines the geographic boundaries for displaying GIS information within a data

frame. These boundaries contain top, bottom, left, and right coordinates. These are the

edges of the map extent. For example, the image below shows a map centered on the U.S.

state of Alabama. The map image also shows the extent boundaries. The units for these

values are the same as the map units. In this case, the map is projected in Albers, and the

map units are meters.

Map extents are affected by map scale. As you zoom in or out of a map, the map extent

changes, provided that the data frame size on the page remains the same.

In some cases, you will want to control the map extent. For instance, you might only be

interested in a geographic subset of your data and want to limit the map user to this area.

Or, you may want to limit users to a particular map scale while allowing them to pan to

different locations. Also, you may want to derive the map extent of one data frame, for

example, an inset map, based on the map extent of a different data frame.

ArcMap provides a number of options in which you can control a map's extent:

• Automatic
• Fixed Extent

• Fixed Scale

• Other Data Frame 44



The default extent option is Automatic. Notice that with this option there are no other

controls or options available in the Extent portion of the dialog box. Appropriate controls

are added based on the extent option chosen.

Autom atic

This is the default option. This option places no restrictions on map navigation. You can

freely pan, zoom, or use bookmarks. When you do, the map's extent and scale change

automatically. If you change the data frame size on the layout, the map extent and scale will

change as the data frame changes.

Fixed Extent

This option keeps the map extent constant. The geographic boundaries of the map—the

top, bottom, left, and right coordinates—are specifically defined. These values should be in

map units.
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There are six ways that you can set a fixed extent:

1. The current extent of the data frame

2. The combined extent of all the features in a specific layer

3. The combined extent of all the features in a specific layer visible in the current map
extent

4. The combined extent of all selected features in a specific layer

5. The combined extent of all or any selected graphic shapes you draw inside the data

frame (in other words, in data view or in a focused data frame) (The graphic or

graphics you want to use to define the data frame extent must be selected;

otherwise, the Outline of selected graphic(s) option will be unavailable.)

6. A rectangle defined by specific coordinates that you supply

If you set Fixed Extent while in data view and the aspect ratio (height /width) of the data

view window is different than the aspect ratio of the data frame on the page layout, the

data frame height and width on the page layout will snap to match the aspect of the data

view. If you intend to create a map layout using a fixed extent, you should set the fixed

extent while in layout view.

Map navigation is restricted for this data frame. You cannot pan, zoom, or use bookmarks. If

you choose this option, appropriate map navigation tools and commands will be unavailable.

If you resize the data frame on the page layout, the map scale will change to keep the extent

constant.

If you resize the data frame on the page layout, the map scale will change. The geographic

area displayed in the map does not change, as illustrated below:
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Fixed Scale

This option keeps the map scale constant. Enter the scale you want to use. You can enter

the scale in absolute format, such as 1:34,000, or in relative format, such as 1 inch = 5 miles.

You can enter scales in absolute or relative format irrespective of what format the scale

control is currently using. When you enter a scale, it automatically is converted to the

current scale format being displayed.

When you type scales into this field, they remain at the top of the list for the duration of

your session so that they can be easily accessed again in this dialog box or anywhere else

scale is specified. To permanently add or remove predefined scales to or from this list, use

the <Customize This List> option, which also lets you change the format that is used to

display scales. Customizations you make to the list of predefined scales and how scale is

displayed are stored as ArcMap settings on your computer; they are not stored in the map

document itself so will not be in effect if the map document is opened on a different

machine.
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A variety of scale formatting is supported:

• In absolute format, the 1: prefix and thousand separators can be present or absent:

1:1,000,000 or 1,000,000 or 1:1000000 or 1000000.

• Any character or word can be used as the separator in absolute format: 1:25000 or 1 -

25000 or 1 to 25000 or 1/25000.

• You can use the following unit abbreviations in relative format: In, inch symbol ("), ft, foot

symbol ('), pt, yd, mi, nm, mm, cm, m, km, dd, dm.

• You can also specify units using their full name in relative formats. The scale control

recognizes units by the first part of their names, so it is not affected if unit names are plural.

You can type any characters after the first part of the name shown here: inch, feet, poin,

yard, mile, naut, mill, cent, mete, metr, kilo, decima, decime.

• Values can be specified in any order: 1:1,000,000 or 1, 000, 000:1 or 1 to 5mi or 5mi to 1.

• One can be given as a number or a word: 1 to 1,000,000 or One to 1,000,000 or One inch =
5mi.

• Any word or character can be used for equals in relative formats. A space isn't required

between a numeric value and the unit's abbreviation or name: One inch = 5 miles or 1in

equals 5mi or 1inch = 5miles or 5 mi to 1 in.

Other Data Fram e

This option derives the map extent for the data frame by taking the current geographic

extent of a different, specified data frame. If you want, you can buffer this extent by a

specified margin. The margin can be specified in map units, in page units, or as a percentage

of the other data frame's extent. You can also use intersection of specified layer features (from 

the data frame whose extent you are customizing) with the extent of the selected (other) data 

frame. 48

You can pan the map to a new

location, but you cannot zoom to a

new map scale. If you resize the data

frame on the page layout, the map

scale will remain. The geographic area

displayed in the map will change, as

illustrated below:



There are a number of ways in which you can use this option. The example below shows an

overview map, the smaller map on the right, whose extent is based on the extent of the

main data frame and includes a margin of

0.1 inch.

The margin is measured from the edge of the selected data frame's geographic extent to the

closest edge of the data frame whose properties you are editing. The margin value is applied

to each side of the horizontal and vertical axes. Since the aspect ratios (width/height) of the

two data frames are not the same, the 0.1 margin is only applied along one axis. The margin

will be larger along the other axis. The size of the difference depends
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on the difference in aspect ratio. If the two data frames share the same aspect ratio, the

margin along the vertical and horizontal axes will be the same. If you use map units, you

will see similar results.

When Data Driven Pages are enabled for a map document, the extent for the primary, or

Data Driven Pages, data frame is tied directly to data. The primary data frame is the data

frame driving the map extent for the pages. You cannot interactively change this data

frame's extent through map navigation tools or commands. Also, you cannot change the

map extent option on the Data Frame Properties dialog box. The Extent arrow is

unavailable.

However, you can still change the map extent properties for any secondary, or inset, maps.

Doing so can achieve a number of desirable effects. For example, the Data Driven Pages

example below shows a page from a map book for U.S. states. Each page contains two data

frames of equal prominence. One data frame shows median home values by county while the

other data frame displays the percentage of homes for rent. The goal is to keep the map

extent for both data frames consistent with each other as each page is generated.
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Note:
The map extent updates if the geographic extent of the active data frame changes. This is 
important if you are using Data Driven Pages. Data Driven Pages allow you to quickly and easily 
create a series of layout pages from a single map document. A feature layer, or index layer, 
divides the map into sections and generates one page of output per section.



You can also derive a map's extent by taking the combined extent of features from a specified

layer that intersect with the extent of another data frame. For example, you have divided a

city's geography into a grid of 60 cells. The map contains a layer, GridParcels, that represents

this grid, and you want to map each individual grid cell. You also want to include an inset map

highlighting this grid cell's location. One way to do this is to use an extent locator. The example

below shows a map for grid cell E4. The inset map in the bottom right shows all grids and

highlights grid E4 in a red outline.

Perhaps you don't want to display all grids in the inset map; you just want to display the

adjoining, or intersecting, grid cells in your inset map. You can do this by defining the extent

of the inset map to use the other data frame (the main map) and to use GridParcels as the

intersecting layer. The inset map will zoom to the extent of the geographic extent of the

other data frame plus the combined geographic extent of each feature in the selected

layer that intersects the extent of the other data frame plus the assigned margin.

As you can see in the example below, the inset map highlights the current grid cell displayed

in the main map and displays the surrounding cells. The inset map changes accordingly based

on the current extent of the Main Map.
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Tip:
If you want the data frame extent to be flush against the edge of the intersecting features, 
enter a margin of 100 percent or 0 if you want to use map or page units. If you want a bit of a 
buffer between the edge of the data frame and the intersecting features, enter a margin 
greater than 100 percent or a value greater than 1 if you are measuring in map or page units.



You should be aware that the scale of the inset map can change. In the example below,

there is only one intersecting feature. As compared to the inset map scale for grid cell E4,

which has GridParcels features on all sides, the inset map scale for grid cell F9 is smaller,

since this grid cell has only three intersecting features.
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Extent Units

The extent is displayed in map units. ArcMap uses the following abbreviations for map units:

Metric units

• Km—Kilometers

• m—Meters

• dm—Decimeters

• cm—Centimeters

• mm—Millimeters

Imperial or international units

• ft—FeetGeographic
• dd—Decimal degrees Other

• pt—Points
• ??—Unknown units

• mi—Miles

• nm—Nautical miles

• yd—Yards

• in—Inches

Automat ic
Fixed

extent

Fixed

scale

Other data

frame

Tools toolbar: Zoom In Yes No No No

Tools toolbar: Zoom Out Yes No No No

Tools toolbar: Pan Yes No Yes No

Tools toolbar: Full Extent Yes No No No

Tools toolbar: Fixed Zoom In Yes No No No

Tools toolbar: Fixed Zoom Out Yes No No No
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Geographic

dd—Decimal degrees

Other

pt—Points
??—Unknown units

Map ext en t o p t io n s an d t h e ir effect
o n m ap n avig at io n

There are many ways in which you can

navigate your map. Map extent options

affect your ability to navigate your map.

The following table identifies which map

navigation tool can be used with the

data frame based on the extent option

placed on the data frame.



Automat ic
Fixed

extent

No

Fixed

scale

Yes

Other data

frame

NoTools toolbar: Previous Extent Yes

Tools toolbar: Next Extent Yes No Yes No

Tools toolbar: XY Yes No No No

ID Results context menu: Zoom To Yes No No No

ID Results context menu: Pan To Yes No Yes No

Find Results context menu: Zoom To Yes No No No

Find Results context menu: Pan To Yes No Yes No

Selection context menu: Zoom To Selected

Features
Yes No No No

Selection context menu: Pan To Selected

Features
Yes No Yes No

Data Frame context menu: Full Extent Yes No No No

Data Frame context menu: Go Back To Previous

Extent
Yes No Yes No

Data Frame context menu: Go To Next Extent Yes No Yes No

Data Frame context menu: Fixed Zoom In Yes No No No

Data Frame context menu: Fixed Zoom Out Yes No No No
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Automat ic
Fixed

extent

No

Fixed

scale

Yes

Other data

frame

NoData Frame context menu: Center Yes

Data Frame context menu: Zoom To Selected

Features
Yes No No No

Data Frame context menu: Pan To Selected

Features
Yes No Yes No

Table context menu: Zoom To Yes No No No

Table context menu: Pan To Yes No Yes No

Table context menu: Zoom To Selected Features Yes No No No

Layer context menu: Zoom To Layer Yes No No No

Layer context menu: Zoom To Make Visible Yes No No No

Bookmarks Yes No Yes* No

*If data frame has a fixed scale, bookmarks can be used. However, the fixed scale is

maintained; therefore, the bookmark may not be displayed using the original map scale

that the bookmark was created under.
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An overview of working with g rap hics

ArcMap contains a set of tools that works on graphics and graphic text. These tools are found

on the Draw toolbar. You can use these tools to create and edit graphics. You can quickly draw

new squares, lines, circles, and polygons, for example, and change how they appear just by

clicking tools. You can convert map elements, such as a legend, to graphics so you can edit

their properties and position them more easily. You can also align and distribute multiple

graphics or move a graphic above or below another graphic on the page. One advantage to

graphics is that you can easily manage different geometry types together.

Working with grap hics

Graphics can be placed either in layout view, along with cartographic elements such as

scale bars and north arrows, or in data view so the graphics resize with your data as you

change the extent of your map.

Graphics are generally map specific, which means that you will want to store your graphics in

individual map documents (.mxd). However, the geodatabase does support the storage of

graphics in annotation feature classes. Use this option if you want to use the same set of

graphics in many maps or if you need to store your graphics in a geodatabase.

Remember that graphics aren't features and have no associated attribute tables and,

therefore, cannot be queried as easily as geographic features.

If you want to store your graphics with your data as features or need to control

multiuser editing, it is recommended that you consider using feature template-

based editing.

Working with grap hic text

Adding text to your map is another way to improve how your map communicates its

message. You can use many of the graphic tools to display and edit text that is added to

the layout view.
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Select ing grap hics

Select graphics with the Select Elements tool        on the Draw toolbar. Select an individual

graphic by clicking it, or select a group by dragging a rectangle around the graphics. You

can also hold down the SHIFT key while



Ab out ad d ing g rap hics and m od ifying their

p rop ert ies

Points, lines, circles, polygons, and rectangles are among the graphic shapes you'll use to

highlight features in your data and draw cartographic elements on your layout. Once you've

added a graphic to your layout, you can move it, resize it, change its color or symbol, align it

with other graphics, and so on. You can also inspect its properties to find its area, length, and

perimeter in the units of your choice, as well as find the x,y coordinates

of point graphics and the center of polygon graphics.

Add ing grap hics in layout view and data view

If you want to add a graphic as part of the map layout, add it in layout view. If you want the

graphic to be displayed with your data, add it in data view. For example, suppose you want

to draw a circle representing a buffer around a feature. Instead of drawing the circle over

the data frame in layout view, draw it directly over your data in data view. Then, as you pan

and zoom your data, the circle pans and zooms with it.

When you are in layout view and want to draw graphics on a data frame so they are displayed

with your data, it's not necessary to switch to data view first. Instead, click the Select Elements

tool on the Draw toolbar

and double-click the data frame. Now when you draw graphics on the data frame, they'll be

added to the data frame instead of to the map layout. Once you've finished, click outside the

data frame with the Select Elements tool.

Graphics you add to a focused data frame in layout view also show up in data view. However,

any graphics you draw in layout view that are not being added to a focused data frame only

appear in layout view.
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selecting to add graphics to, or remove them from, the current selection. You can tell when a

graphic is selected because ArcMap draws selection handles around it. When more than one

graphic is selected, one graphic has blue handles and the others have green handles. The blue

handles indicate the dominant graphic, or the one that ArcMap will use to align other graphics

with.

To change the dominant graphic, hold down the CTRL key and click the selected graphic that

you want as the dominant one.

If you are in layout view and find that you can't select a graphic because it was added in

data view, give the data frame focus.



Ab out m ap p rint ing

Often, map printing can be more involved than simple printing of word processing

documents or PowerPoint presentations. Map files can be very large in size and temporarily

consume large amounts of disk space while printing. In addition, the page dimensions of

your map layout may exceed the size of your printer paper. This topic covers a number of

considerations and options available when printing maps in ArcGIS.

Sett ing up m ap p rint ing for p lotters (large form at p rinters)

Your GIS organization is likely to have printers that handle page sizes larger than small

format office printers. An important initial step will be to reference your large format printer

in ArcGIS. To change the printer, open the Page and Print Setup dialog box and use the

Name drop-down to set the current printer.

Sett ing the p age size of your m ap layout

Since a layout is the arrangement of map elements of various types on a page for printing,

one of the obvious initial steps in building your layout is to set the desired page size using the

Page and Print Setup dialog box. By default, when you create a new map in ArcMap and

choose Blank Map, the layout page dimensions are set to your default printer's page size.

Steps for sett ing the layout's page size

1. Click File > Page and Print Setup on the main menu to open the Page and Print Setup
dialog box.

2. You can set your layout page size as shown here.
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By default, the page size of your layout for a blank map will be set to the printer's

paper size (for example, 8.5 by 11 inches).

3. To set your own page size, uncheck the Use Printer Paper Settings check box to set the

page size of your layout. If you uncheck this option, you can choose any page dimensions

you want, but the printer name will not be saved with the map document (.mxd).

4. Set the page size by typing the preferred page dimensions into the Width and Height
boxes.

Alternatively, you can select a standard page size from the Standard Sizes drop-down

list, such as ANSI C, Architectural D, or ISO A2.
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Note:
You may want to change the printer to a large format printer (plotter) in your organization. 
Use the Name drop-down to set the current printer.



5. Once you change your layout's page size, you will need to resize and reposition all the

map elements to fit the new page dimensions. This is necessary even if you are working

with a brand new map and have yet to begin adding any map elements or layers.

Map Page Size is linked to the Paper Size of the current printer whenever the Use Printer

Paper Settings checkbox is checked. By default, this option is checked for new maps

created via the Blank Map option in the New Document or ArcMap - Getting Started

dialog boxes. In the example below, the printer setup Paper Size used as the default by

ArcMap is 8.5 x 11 inches. However, the Map Page Size has been unlinked from the

original 8.5 x 11 size and set to a larger page, 22 x 34. The initial data frame was

placed on the layout based on the original, smaller, page size. So, after changing the

Map Page Size, you need to use the layout view in ArcMap to rearrange your layout.

Reposition the data frame and layout elements so that they will work well with the new

page size.
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Exp ort ing your m ap

Once you have created your map, you have a number of choices for sharing it. This topic

provides details of the various map export options, along with a brief overview of other ways

to share your maps with others.

Sometimes the term export can mean exporting individual map layers to other data

formats. That type of export is referred to as exporting data. This help topic discusses

exporting maps, exporting the full map image to graphics interchange files using the ArcMap

Export Map command (File > Export Map).

Map exp ort form ats

You can export maps to several industry-standard file formats. EMF, EPS, AI, PDF, and SVG are

referred to as vector export formats, since they can contain a mixture of vector and raster

data. BMP, JPEG, PNG, TIFF, and GIF are referred to as image export formats. These are raster

graphics file formats.

The 10 supported export formats are listed below.

File format
Descrip t ion

EMF (Windows

Enhanced

Metafile)

EMF files are native Windows graphics files that can contain a mixture of vector and raster 

data. They are useful for embedding in Windows documents because the vector portions

of the EMF can be resized without loss of quality. However, since EMF does not support

font embedding and is exclusively a Windows format, it is not commonly used as an

interchange format between users.

EPS

(Encapsulated

PostScript)

EPS files use the PostScript page description language to describe vector and raster 

objects. PostScript is the publishing industry standard for high-end graphics files, 

cartography, and printing. EPS files can be edited in many drawing applications or placed

as a graphic in most page layout applications. EPS files exported from ArcMap support

embedding of fonts so that users who do not have Esri fonts installed can still view the

proper symbology. EPS exports from ArcMap can define colors in CMYK or RGB values.

AI (Adobe

Illustrator)

AI files are an excellent format for postprocessing in Adobe Illustrator as well as an

interchange format for publishing. The ArcMap AI format preserves most layers from the
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File format
Descrip t ion

ArcMap table of contents. However, the Adobe Illustrator file format that ArcMap writes

does not support font embedding, so users that do not have the Esri fonts installed may

not be able to view AI files with the proper symbology. AI exports from ArcMap can

define colors in CMYK or RGB values.

PDF (Portable

Document

Format)

PDF files are designed to be consistently viewable and printable across different

platforms. They are commonly used for distributing documents on the web, and the

format is now an official ISO standard for document interchange. ArcMap PDFs are

editable in many graphics applications and retain map georeference information, 

annotation, labeling, and feature attribute data. PDF exports from ArcMap support

embedding of fonts and thus can display symbology correctly even if the user does not

have Esri fonts installed. PDF exports from ArcMap can define colors in CMYK or RGB

values. For detailed information on exporting to PDF, see Exporting to PDF.

SVG (Scalable

Vector Graphics)

SVG is an XML-based file format that has been specifically designed for viewing on the

web. SVG can contain both vector and raster information. Some web browsers may

require a plug-in to view SVG files; older browsers may not be able to view SVG files at all. 

SVG supports font embedding, so users who do not have the Esri fonts installed can still

view ArcMap SVG exports with proper symbology. ArcMap can also produce compressed

SVG files. The file extension changes to *.svgz when this option is enabled.

BMP (Microsoft

Windows

bitmap)

BMP files are simple, native Windows raster images. BMPs can store pixel data at several

bit depths and can be compressed using the lossless RLE method. BMP images are

typically much larger than formats such as JPEG or PNG.

JPEG (Joint

Photographic

Experts Group)

JPEG files are compressed image files. They support 24-bit color and have been a popular 

choice for use on the web because JPEG file size is often substantially smaller than many

other image formats. However, the JPEG compression algorithm is lossy and is not

recommended for most map images, as line drawings and text or iconic graphics become

blurred by compression artifacts. Thus, PNG is usually a superior format for map images. 

JPEGs exported from the data view in ArcMap can be generated with an accompanying

world file for use as georeferenced raster data.

PNG (Portable

Network 

Graphics)

PNG is a versatile raster format that can be displayed in web browsers and inserted into

other documents. It supports 24-bit color and uses a lossless compression. For maps, PNG

is often the best raster format, since the lossless compression keeps text and line work 

legible by preventing the compression artifacts that can occur in JPEG format. PNG files

also have the ability to define a transparent color; part of the image can be displayed as

transparent in a web browser, allowing backgrounds, images, or colors to show through. 

PNGs exported from the data view in ArcMap can be generated with an accompanying

world file for use as georeferenced raster data.
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File format
Descrip t ion

TIFF files are the best choice for importing into image editing applications and are also a

common GIS raster data format. However, they cannot be natively viewed by a web

browser. ArcMap TIFFs exported from the data view also support georeferencing

information in GeoTIFF tags or in a separate world file for use as raster data.

TIFF (Tagged

Image File

Format)

GIF (Graphic

Interchange

Format)

GIF files are a legacy raster format for use on the web. GIFs cannot contain more than 256

colors (8 bits per pixel), which, along with optional lossless RLE or LZW compression, 

makes them smaller than other file formats. Like PNG, GIF files also have the ability to

define a transparent color. GIFs exported from data view in ArcMap can be generated

with an accompanying world file for use as georeferenced raster data.

Configuring m ap exp ort

The ArcMap Export Map dialog box allows you to control the settings used to create the

export file. In most cases, using the default values should produce a usable file, but you can

set options for each export format to create output for specific requirements.

Resolut ion

This specifies the output resolution or dpi (dots per inch) in the output image. Higher values

usually produce sharper images. However, this can also substantially increase the file size and

processing time. For vector export formats, the default resolution is 300 dpi. For image export

formats, the default resolution is 96 dpi.

Output Im age Quality

For vector export formats, you can control output image quality to help balance image

quality with file size and processing time. The default output image quality setting is Best (1:1).

Output Image Quality controls the amount of raster resampling. If your map does not contain

raster data or vector layers with transparency, setting the output image quality will not impact

the output quality of your map.

The Output Image Quality control determines the effective resolution of raster content on

output. For instance, if the output image quality ratio is set to 1:2 and the output resolution

is set to 300 dpi, the raster content will be output at approximately 150 dpi.
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You may need to experiment by exporting or printing a small map at several Output Image

Quality settings to determine the best setting for your map contents. You can create a small

map containing samples of the data and other map elements that you intend to include in

your maps. Output the sample map at various settings. Experiment to find a dpi and suitable

quality mode that produces high-quality output with minimal processing time.
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 When Output Image Quality is set to Best, the image is of much higher quality.

 When Output Image Quality is set to Fast, the preview image is highly pixelated.

 When the Output Image Quality slider is set to Best (i.e., a ratio of 1:1), no resampling

will occur. By default, Output Image Quality is set to Normal.



Exp ort ing to PDF

PDF, the Portable Document Format, is a popular graphics file format that supports vector

and raster graphics in a single compact file. A single PDF file can contain multiple pages, and

the format has the ability to preserve layers and graphic feature attributes and map

georeference information. PDF is one of the most widely used ways of publishing geographic

information to non-GIS users and is an important archival and hard-copy press exchange

format.

Because a large majority of computers already have Adobe Reader or Adobe Acrobat

software installed, you should consider exporting your map to PDF when you need to reliably

exchange a map with a non-GIS user. PDF files are especially useful when you want to provide

a document that can output to a printer in addition to being viewed on-screen. Because PDF

allows preservation of vector graphics and embedded fonts, it will provide the best

opportunity for a high-quality print by the end map user.

You should also use PDF when you wish to provide a simple, self-contained interactive map

viewing experience. PDF documents store all map information in a single file, making it is a

useful medium for sharing content with those who work in locations where a network

connection is not available. Exporting map layer information and georeference information

can geoenable the PDF document, allowing the user to interact with and search through the

map content.

Configuring PDF exp ort sett ings

ArcMap's Export Map dialog box allows you to control the settings used to create the PDF

file. For most cases, using the default values should produce a usable file, but you can set

export options to create output for specific requirements.

Resolut ion

This specifies the output resolution or (dots per inch) in the output image. Higher values

usually produce sharper images. However, this can also substantially increase the file size

and processing time. For PDF, the default resolution is 300 dpi.

Output Im age Quality

The Output Image Quality control is intended to resample raster data prior to printing or

exporting the map. For maps with raster data or transparent vector layers, adjusting this

value can significantly reduce the amount of data being passed through the output pipeline

and will reduce export times and file sizes.
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Advanced PDF features

PDF files exported from ArcMap can include advanced functionality in addition to their usage

as a graphic interchange format. PDF files can contain layers from the ArcMap table of

contents so that users can enable and disable the visibility of layers and graphic elements on

the PDF page. PDF files exported from ArcMap can also include attributes for GIS features as

well as georeference information for each map data frame. Anyone viewing the PDF

document in Adobe Reader or Adobe Acrobat can use the Acrobat Analysis tools to inspect

feature attributes and look up and identify geographic coordinates. The following sections

contain information about these advanced features and their usage.

PDF layers

ArcMap PDF exports can contain layers whose visibility can be controlled in PDF viewing

applications. To enable layers in a PDF export, select the Export PDF Layers Only option or the

Export PDF Layers and Feature Attributes option under the Layers and Attributes drop-down

menu on the Export Map dialog box's Advanced tab:

Most ArcMap table of contents layers, data frames, and layout elements will be included as

separate layers in the export. However, certain types of symbology may affect the

presentation of a layer in the finished PDF. Refer to the graphic below for an outline of the

PDF layer creation from within ArcMap. 66

PDF Form at options

Destination Colorspace controls the color space in which colors are specified in the output

file. RGB is the default and is appropriate for on-screen viewing and printing to inkjet or laser

printers. CMYK mode is intended

for commerical print production, when your output will be sent to a print shop. If you want to

compress the vector portions of your PDF to produce a smaller output file, check the

Compress Vector Graphics option. There is a separate Image Compression option for

compressing raster portions of the PDF. Adaptive mode produces the smallest file size but

may produce compression artifacts on the export image. For lossless compression of raster

images in the PDF, use Deflate mode. The Embed All Document Fonts option allows you to

include the fonts that are used within the document itself. This allows the PDF to look the

same when opened on any platform that supports PDF viewing, even if the platform does not

have the document's fonts installed. This is the default and should usually be used.

The Export PDF Layers Only
option will add PDF layers
without adding attributes.



Below are some facts and tips concerning PDF layer creation from ArcMap:

• Each data frame will have its own folder in the tree view of the PDF that contains all

the layers and the data frame graphics (neatline, background) associated with it.

• Text, picture, or north arrow elements added to a layout become part of a layer called

Other. It contains all the graphics and marginalia that are not part of a data frame.

• Each group layer will be represented as a folder in the tree view, and the contents of

the group layer will be presented within the group layer.

• Layers that cause rasterization, such as transparent layers, or layers that use a

picture fill symbology consolidate all the layers below them into a single layer with

the name Image.

• If a layer contains picture marker or picture fill symbology, use the option Vectorize

picture markers/fills, found on the Format tab of the Options panel. This prevents

rasterization of layers below picture markers and fills.

• Raster layers, such as orthophotos, consolidate all layers below them into a single

Image layer. Place raster layers lower in the ArcMap table of contents to avoid this

problem.

• Graphic or text elements added to the data frame's default graphics layer from data

view become a layer called <Default>. These are displayed above the layers in the data

frame. If multiple annotation groups exist (check this on the Drawing > Active Annotation

Target menu command on the Draw toolbar) and their contents are in the data view,

each individual annotation group becomes a separate layer above the

<Default> layer. This is a good way to add focus areas or graphics that emphasize

or mask certain features in the data view.

• Backgrounds or drop shadows added to the data frame may become separate graphic

elements and may be rendered multiple times as graphics. For example, if a data frame

has a colored background, and the layout has a different colored background, the data

frame's background may be rendered once to the data frame's Graphics or ArcGIS Layer

and again to the layout's Graphics layer or ArcGIS Layer.
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• Dynamic labels (not using annotation) in each data frame are rendered separately

as part of a layer called Labels.

• Geodatabase annotation is displayed as a separate layer in the PDF. Map annotation is

consolidated into the layer for the annotation group in which it belongs.

• When labels are converted to annotation, they are automatically placed in their own

named annotation group and render separately from the <Default> group.

• Data frames and other layout elements are rendered in draw order when exported to

PDF. Therefore, the topmost layout element in the map is the first element in the

resultant PDF table of contents. Use the Bring Forward and Send Backward commands

from the Draw toolbar to change the draw order of layout elements.

PDF attributes

PDF files exported from ArcGIS can include feature attributes from the feature's attribute

table using functionality built in to Adobe Acrobat and Adobe Reader. This option can be

enabled by choosing the Export PDF Layers and Feature Attributes option from the Advanced

tab of the Export Map dialog box:

The visibility of fields in the feature's attribute table determines what fields will be exported in

the resulting PDF. To turn these fields on and off, go to the Fields tab of the Layer Properties

dialog box. The check boxes determine the visibility of the given field. Check or uncheck the

check boxes to expose more or fewer attributes in the resultant PDF.
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The Export PDF Layers and Attributes option enables both PDF layers and the export of attributes 
based on options chosen in the Fields tab of the Layer Properties dialog box.



The Fields tab on the Layer Properties dialog box showing visibility of attribute table fields

Alternatively, the visibility of the fields can be controlled in the Table window by right-clicking

the column heading and choosing the Turn Field Off option:

The Turn Field Off

shortcut menu

option also toggles

field visibility,

disabling its export in

the PDF attributes.

69



People using your PDF can access these attributes in Adobe Acrobat and Adobe Reader using

the Object Data tool (see Tools > Object Data, or enable the Model Tree view in either of

those programs).

PDF m ap georeference

Adobe Acrobat and Adobe Reader versions 9 and later allow viewing of map coordinates

and georeference information encoded inside the PDF file. Exporting a map with the

Export Map Georeference Information

option enabled will record each data frame's georeference information inside the PDF. When

the georeferenced PDF is opened in a compatible viewer, such as Adobe Reader 9, the user

can access geospatial functions such

as coordinate readout and finding x,y.

The Export Map Georeference

Information check box on the

Advanced tab of the Export

Map dialog box
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Caution:
Exporting attributes to PDF can result in performance problems in compatible PDF viewers. If 
possible, limit exported fields to one layer per map. To suppress field export, turn off field 
visibility in the Layer Properties dialog box.



Note:

The geospatial functionality available to Adobe Acrobat and Adobe Reader users

depends on which Acrobat 9 product they are using. When a PDF exported from

ArcMap is used directly in the free Adobe Reader 9 product, tools for coordinate

readout and find x,y will be available. If that same PDF is opened in any of the pay-for

Acrobat products, an extended geospatial toolset is provided, including coordinate

readout, find x,y, geodesic measurement, and georeferenced markup. This same

extended toolset can be accessed in the free Adobe Reader if the PDF has first been

resaved in Adobe Acrobat 9 Pro or Pro Extended using the Extend Features in Adobe

Reader command in those programs.

Enabling PDF for extended Adobe Reader features is only available in software from

Adobe Systems, such as Adobe Acrobat Pro, and cannot be performed in ArcMap.

The georeference information saved inside the PDF file contains the following for each data

frame on the page layout: corner coordinates of the data frame's boundary, both in latitude

and longitude and in PDF page units (points), and a string describing the data frame's

coordinate system as defined in the data frame properties coordinate system options. This

information is saved into the internal stream of the PDF file for use by Adobe Reader or

Adobe Acrobat, and the raw data is not user viewable. When a map is exported from data

view instead of layout view, the PDF will contain a single map image along with its

corresponding georeference information.

PDF files containing georeference information are still compatible with earlier (pre-Acrobat 9)

versions of Adobe Acrobat and Adobe Reader. Files will open without problems, but the

coordinate-related functions will not be available. Exporting to PDF with the Georeference

option enabled does not negatively impact performance. Export takes the same amount of

time with the option on or off. With these facts in mind, you may wish to keep the option

enabled for all map exports. However, if you desire to not have the georeference

information included in the PDF file, uncheck the Export Map Georeference Information check

box to suppress export of georeference information.
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